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WEPP Windows Quick Start Guide 
 

This version of the Water Erosion Prediction Project (WEPP) model is designed to run on personal computers under 

the Microsoft Windows 95 and above operating systems.   

 

The WEPP Windows interface software can be either downloaded from the NSERL web site at: 

 

http://topsoil.nserl.purdue.edu 

 

The installation file is wepp2012install.exe – double-click on the file and the installation program will begin.  

Follow the on-screen instructions to install the WEPP model, CLIGEN climate generator, and Windows interface for 

WEPP. 

 

 

 

Disclaimer 
 

All WEPP information, computer software, and databases are believed to be accurate and reliable. The main 

objective of the Water Erosion Prediction Project model is for it to be used as a soil conservation planning tool by 

USDA, other federal, state, and local agencies, and private consultants, individuals, and organizations involved in 

natural resource planning and assessment.  The United States Department of Agriculture, the Agricultural Research 

Service, and Purdue University accept no liability or responsibility of any kind to any user, other person, or entity as 

a result of installation or operation of this software. The software is provided "AS IS," and you, its user, assume all 

risks when using it. 

 

WEPP is in the public domain and you are free to use it.  ARS would appreciate your comments on the model's 

capabilities and limitations. Please send comments to WEPP Technical Support at the USDA-ARS National Soil 

Erosion Research Laboratory (NSERL).  

 

The WEPP programs, databases, and other information were developed with funds from agencies of the United 

States Government, and legally may not be copyrighted. 

 

If the executable code of the current version is downloaded and used within a larger software package, please 

acknowledge the source and include this preface. 

 

Requests for additional information should be made to:  

 

WEPP Technical Support 

USDA-ARS NSERL 

1196 Building SOIL 

West Lafayette, IN 47907-1196 

Phone:  (765) 494-8673 

FAX:  (765) 494-5948 

email:  wepp@ecn.purdue.edu 

WWW:  http://topsoil.nserl.purdue.edu 

http://topsoil.nserl.purdue.edu/
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WEPP Windows Interface Tutorial 

 

Introduction 
 

This WEPP software consists of an erosion prediction model (WEPP) written in the FORTRAN programming 

language, a climate generator program (CLIGEN) also written in the Fortran programming language, and a 

Windows interface (WEPPWIN) written in the Visual C++ programming language.  The interface accesses 

databases, organizes WEPP and CLIGEN simulations, creates all necessary input files for WEPP and CLIGEN, and 

executes the science models when necessary.  The interface also accesses and processes output information from the 

models for display and access by the user. 

 

Section 1.  WEPP Software Installation 
 

The WEPP model and Windows interface can be installed from the installation program downloaded from the 

NSERL web site.  At the time of this document revision, the installation executable file was wepp2012install.exe. 

This install program includes  the August 2012 WEPP model release.  

 

Use Windows Explorer to locate the installation file “wepp2012install.exe” in the directory in which you 

downloaded it from the NSERL Web site.   Use the mouse to double-click on the wepp2012install.exe file.  This 

will start the installation process. 

 
 

 

The installation process includes the following screens: 
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Figure 1 Welcome Screen: Click the Next> button 
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Figure 2 General Information on Release: Click the Next> button 

 

 

Figure 3 Choose Install Directory: Click the Next> button. 
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You can install the WEPP programs to the default directory, which is c:\wepp, or you can choose a directory of your 

own.  Choose the default location by clicking Next. 

 

 

Figure 4Choose Start Folder Name: Click Next> button. 

 

 

The user can then select the Program Folder in which to locate the program icons.  The default USDA Applications 

is chosen, then the user clicks on the Next button. 
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Figure 5 Install Desktop icon: Click Next> 

 

The setup for the installation is now complete, and the information on the current settings are provided in the 

following screen.  If the user is happy with the settings, they will click on the Next button to proceed with the WEPP 

installation. 
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The installation now proceeds automatically, installing the WEPP model, CLIGEN model, and WEPP Windows 

interface to the user’s computer, with the screen below visible as the files are copied. 

 

Figure 6 Copying files 

Once all of the files have been copied and registries updated, the installation program produces the following final 

screen.  The user clicks the Finish button to end the installation. 
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Figure 7 Installation Complete 
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The WEPP Windows program can now be run by clicking on the Start button on the Windows toolbar, then moving 

the mouse cursor to Programs, then to USDA Applications then to WEPP Interface, as shown in the screen below 

and clicking with the left mouse button.  This will start the program. 

 
 

You can also start the program by clicking on the desktop icon. 
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 Section 2.  Running WEPP – Basic profile simulation run 
 

A. Starting the Interface and Running the Default Project 

 

Start the WEPP program by selecting the WEPP Interface under Programs, or clicking a created shortcut icon.  The 

main program startup screen will appear.  The interface loads with a default hillslope profile project visible, with all 

inputs ready to make a WEPP simulation run (the default project can be changed and overwritten by the user). 

 

 
 

The WEPP Windows interface organizes simulation setups by projects.  A project is a file that describes how to run 

a simulation, what model options are used and the data necessary to create the model input files.  

 

 
 

 



 12 

The Start screen allows a user to run the default WEPP project, or to access other types of WEPP projects.  The Start 

screen can also be turned off so that it does not appear when the interface is started again by checking the box at the 

lower right of the window. 

 
 

The task selector screen determines what project is initially displayed: 

1. Use the default WEPP Project – Loads and runs default project 

2. Create a new hillslope project – Steps for creating a new project 

3. Open an existing hillslope project – Loads an existing project  

4. Open a worksheet project set – Loads a spreadsheet of existing projects 

5. Open a watershed project – Loads a watershed simulation project 

 

If you just select the default to Use the default WEPP project, then click on the Start Task button, the interface will 

run the WEPP model with the default inputs and display the results on the main profile screen, displayed below. 
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The main Windows interface screen shows a graphical depiction of a hillslope profile, with various areas providing 

access to input databases and output display.  The profile shape is drawn based upon the model slope inputs, which 

can be accessed through the middle layer on the graphic.  Soil information can be accessed through the bottom layer 

on the graphic, and the cropping/management information through the top profile layer.  Climate inputs can be 

selected or generated through the icon at the top center of the screen.  The horizontal profile length dimensions are 

provided at the bottom of the screen in either metric or English units. 

 

Notes associated with the project can be viewed and entered in the note area at the upper left of the screen.  The 

input slope file used in the current project is listed as is the input climate file, and both the Slope File and Climate 

File entry fields have drop downs which allow selection of any other existing files in the database.  The small file 

folder icons to the right of the these input areas allow direct access to the slope and climate view/editing screens. 

 

At the bottom of this screen is detailed information on soil detachment and deposition by management and by soil 

region.  In the default project there is only a single management and soil, so only a single line is displayed.  The 

name of the management rotation and the soil information from the databases being used in the current simulation 

are displayed on the first line of the table, and other managements or soils can be selected from the dropdown lists.  

Clicking on the small file icons to the right of the management or soil names will access the management rotation 

editor or the soil editor, respectively. 

 

 

B. Viewing Model Output from the Default Project Run 

 

Since the model has already run for the default input set, hydrologic and soil loss output is displayed on the screen in 

both the small table at the upper right corner of the screen, as well as in the slope (middle) layer on the profile.  The 

table provides average annual precipitation, runoff, soil loss (from detachment regions), and sediment yield from the 

entire profile, with the years of simulation run shown as the table header.  The average annual soil loss or deposition 

is shown in shades of red or green, respectively, in the slope layer.  In the screen image above, the maximum erosion 

is predicted to occur in the center part of the profile, where slope steepness is greatest.  Also, erosion rates are lower 

near the top and bottom of the profile, and no deposition is predicted on the profile.  Soil loss or deposition values at 
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individual points down the profile can be displayed by hovering the mouse cursor over the slope layer at the desired 

location. 

 

Additional output can be viewed by clicking on the Soil Loss Graph, Graphical Output, or Text Output buttons at the 

bottom of the main screen. Each of these is discussed below. 

 

 
 

Soil Loss Graph 

 

A graph of soil erosion and deposition for the profile can also be displayed by clicking on the Soil Loss Graph 

button.  The following window will appear which depicts the spatial average annual soil loss values down the profile 

– the information is the same as that in the profile shown on the previous page in shades of red and green. 

 

 
The dark red line represents the slope profile. The green line near the slope profile is a representation of the soil loss 

or deposition for the corresponding points on the profile. Where the two lines are close together little erosion is 

occurring, where the lines are further apart more erosion is occurring. In the graph above most soil loss is occurring 

towards the end of the steeper middle section. The shaded area graph at the bottom is the same information 

displayed with the actual rates on the Y axis. 

 

Text Output 

 

Text output from the WEPP model can be selected and viewed by clicking on the Text Output button at the bottom 

of the main screen. In addition to the WEPP model output files the model input files can also be viewed. 

 

 

 



 15 

 
 

 

A small window will appear listing the available WEPP text files to view:  Either select the desired output and click 

on the View button, or just double click on the desired output name. 

 

 
 

 

The default text file to view is the Main WEPP Output.  This output file contains the detailed hydrologic and erosion 

results from the simulation, and is displayed in either Notepad or Wordpad. 
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Graphical Output 

 

An additional graphical output from the model is available (when selected in the Run Options screen) which 

displays 90 daily parameter values from the WEPP model.  To view the graphical output, click on the Graphical 

Output button at the bottom of the main screen.  
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When the graphics output window appears, use the drop-down lists to select variables for the Y, Y’(second axis on 

right), and X axes.  The plotting style can also be changed, and variables which have unique values on individual 

Overland Flow Elements (OFE – which is a region on a profile of homogeneous soil and cropping/management) can 

be displayed.  Up to four graphs can be displayed at one time.  The graphs have many options, such as resizing and 

printing. Right click with the mouse when the cursor is over a graph to display these options. Zooming is 

accomplished clicking and holding down the left mouse button on the left edge of the region to be zoomed into, then 

dragging the mouse cursor to the right edge of the zoom region.   

 

C. Changing WEPP Model Run Options and Running the Current Project 

 

Two additional buttons at the bottom of the main screen allow you to Run the WEPP model for the current project as 

most recently configured, and to change the Run Options for the project.  Click the Run Options button. 

 

 

 
 

 

 

 

 

 

 

The Run Options screen will appear.  This screen allows you to 

select the types of WEPP output you would like to create, as well 

as the number of years in a continuous simulation.  In normal 

WEPP applications, a simulation period of 30-100 years is 

recommended.  However, a 30-100 year simulation will generate 

extremely large model output files. If you run long simulations, 

select Annual, abbreviated as the output option and do not check 

most output options. 
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Let’s change the Simulation years from 1 to 

10, then click the OK button.  Once back to 

the main profile screen, click the Run button 

to run the WEPP simulation again, this time 

for 10  years. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

A small window will appear in the center of the screen which displays the progress of the WEPP model simulation.   

 

 
 

 

 

 

When the new 10 year simulation is completed, the numbers in the output displays will all be updated. 
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D. Return Period Analysis 

 

Return period (also known as recurrence interval) is the average elapsed time between occurrences of an event with 

a certain magnitude or greater. 

 

Methodology used:  The daily event data are ranked from the smallest to the largest after zero values are removed.  

Using the Weibull plotting position formula, 

the return period between occurrences of each 

event is computed as  

 

Return Period = (N/k)/[1-R/(k+1)] 

 

Where N is the number of years of data, k is 

the number of events, and R is the rank (with 

1 being the rank of the smallest value and k 

being the rank of the largest value). 

 

It is recommended that for return period 

estimates, a minimum run length be at least 

twice as long as the longest return period.  

Results should be carefully scrutinized to 

ascertain reasonableness, and in some cases 

where very few events occur, such as for 

desert or dryland conditions, much longer run 

lengths may be needed. 

 

To setup return period outputs click on the 

Run Options button and select the Return 
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Period Summary item. Also change the number of years for the simulation to 100. The graphics output item should 

not be selected. 

 

Next, click OK to return to the main WEPP window and ten click the run button. This will run a 100 year WEPP 

simulation. The Return Periods button should now be active at the bottom of the screen. 
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Click on the Return Periods button to display the return period table. The longest return period is ½ of the 

simulation time. The results show the magnitudes of different events and how often they may occur. For example, 

every 25 years, one runoff event 47.7 mm in depth could occur. 

 

 

 

 
 

The times for the return period can be adjusted by changing the return period field and then clicking the Set button.  

The results can also be displayed in a graph by selecting the column to graph and then clicking the Display button. 

 

 

E. The Upper Toolbar Icons for Performing Common Tasks  

 

The toolbar at the upper part of the screen contains 14 icons that allow a user to rapidly accomplish common tasks.  

Some of these tasks are typical of any Windows program, while others are specific to the WEPP interface.  The 

entire set of buttons looks like this: 

 

 
 

The icons left to right represent opening a new project, opening an existing project, saving the current project; 

cutting, copying, pasting, and deleting active areas on the screen (when possible); importing and view/editing active 

layers; toggling between English and metric units;  customizing user display preferences; toggling between the 

standard profile view and one with input choices on the main screen; printing output information for the active 

project; and accessing the on-line help for the interface. 

 

Changing the main View 

 

If the user clicks on the view toggle as shown in the previous figure, the main project screen will change to: 
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In this view, there is not as much project input and output information displayed on the screen.  Moving the mouse 

over the different layers and the climate icon the right-click menu can be used to display options to view/edit the 

selection or import a new selection. 
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Customize User Preferences 

 

Clicking on the checkmark icon will bring up the user preference customization screen. 

 

 

The User Preferences screen allows changes which will apply to the general screen and project appearance.  For 

example in the View window visible below, the current settings are for displaying the slope as a 3-D image, showing 

the soil loss erosion gradient in the slope layer on the main screen, displaying input areas on the main window, using 

English units, and displaying the output table grid.  The Set limit for average detachment option allows you to set 

a threshold for displaying erosion as red – thus if you entered a hypothetical soil tolerance value of 4 tons/A in this 

option screen, all values of detachment above 4 would be colored pure red, with scaling from white to red for 

detachment values from 0 to 4 tons/A. 
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Under the Graphics tab, the user can select or de-select which of the large graphical outputs are desired to appear in 

the picklists.  Thus if you are only interested in choosing the daily hillslope Soil Loss/Sediment Yield output in the 

graphics output, you could press the Clear All button, then click to enable the seven outputs in that section. 

 

 
 

To exit the User Preferences screen, click the OK or Cancel button. 
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Inserting Breaks in the Soil and Management Layers 

 

The WEPP model is very powerful in that it allows simulation of different soils and/or management down a profile.  

To insert breaks in either the soil or management layers move the mouse pointer to the position where you would 

like the break to be placed. With the mouse pointer over the correct position right-click and then select the Insert 

Break menu item from the popup menu.  

 

 
 

 

Notice in the figure below the line splitting the layer as well as the two rows of Duncanon soil in the soil table at the 

bottom right of the screen.  The management layer may be split in exactly the same way. 

 

 

Click on Insert break menu 

item to add the break. 
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Importing Different  Soils, Management, Slope or Climate Information 

 

Any existing soils, management, slope, or climate information may be 

imported into the current project in a variety of ways.  One way in the 

common view shown in the previous figure is to click on the drop-down list 

and select another item from the database.  For example, if you would like to 

select a different soil for the new lower soil section that was just created in the 

previous step, you click on the second Huangmia line in the Soil table at the 

bottom right of the screen. 

 

If you select the Keith soil from the picklist, the new soil information is 

accessed and the lower soil section changes color to brown, which is the Keith 

soil color. 

 

 

 

 

 

 

 
 

 

Now, run a 10 year simulation, and look at the results: 



 27 

 
The soil loss values depicted and the table values for Average Detachment show that there is lower soil loss on the 

Keith soil.  Thus the soil properties have impacted the local and total erosion on the profile. 

 

Another method of changing the soil is to right click on the soil section to change and choose Import from the menu: 

 
 

A window is then displayed and the new soil can be selected.  
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You can also import another selection into a data entry layer by highlighting the layer with a left mouse click, then 

pressing the import button  on the top icon toolbar.   

 

F. Special Mouse Functions  

 

The mouse has some powerful functionality.  The mouse can be used for some of the same 

functions as the different icon buttons, and it also has some additional functions which are 

needed to change segment lengths.  For example, if you left click with the mouse on the 

Keith soil section so that it is highlighted (cross-hatched), then right-click with the mouse, 

the following screen will appear.  Here you have the options to edit the Keith soil 

parameters, copy the Keith soil parameters into the buffer, cut the Keith soil section out of 

the layer, delete the Keith soil from the soil layer, import a different soil into the section 

the Keith soil is currently occupying, insert a break point or change the length of the Keith 

section. 

 

The Change Length option allows entry of an exact distance value for the 

highlighted section.  Here 23 meters has been entered. 

 

After running the simulation again with the new section length, delete the Keith soil 

region. 

 

G. Other WEPP Project Options Available from Main Menu  

 

The main menu for the Windows interface appears at the top of the program screen.  Main menu options are File, 

Edit, View, Option, Window, and Help. 
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By clicking on the File option, a dropdown window will appear: 

 

File options include typical Windows functions such as open a New 

project, Open an existing project, Close the current project, Save the 

current project, and SaveAs the current project.  There is also the ability to 

Print, Print Preview, and Print Setup the current project.  Most recently 

opened projects are displayed in a list at the bottom of the window.  

 

A very important function is “SaveAs”.  All of the default projects (and 

databases) initially installed with the WEPP model are write protected.  

Thus, a user must save their new information and runs under their own 

new and unique names.  Select “SaveAs” under the File options.  Then, 

save the current project under a new name, as shown in the following 

figures. 
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The current project will be saved under the new name (wepp-test-1 in this example), and also the name for the active 

project on the screen will also change to the new name. 
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Some unique options also exist in this dropdown window:  Open Project 

Set, New Project Set, and Open Watershed.  The Open Watershed option 

allows the user to open existing watersheds to edit and run WEPP 

simulations on, and will be discussed later in this tutorial.  The Project 

Set options allow the user to define and run groups of hillslope profile 

projects of special interest to the user. 

 

 

 

 

 

 

 

Click on New Project Set, as shown in the window here.  The following 

screen will appear: 

 

 
This screen allows you to group existing projects into a table set, and run them at the same time, run all of them with 

a common climate, slope, soil or management file, and save them as a named set. 

 

Click on the Add Projects to Set button as shown above, and create a sample Project Set.  The next screen will 

appear, listing all of the existing hillslope profile projects that currently exist in the default directory.  You can select 

from these or select projects located elsewhere on your PC.  
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Create a project set containing three of the alfalfa projects.  Click on the “alfalfa” project with the left mouse button, 

hold down on the Shift Key and then click on the “corn,soybean,wheat,alfalfa(4yrs)- no till” and thn the 

“corn,soybean,wheat,alfalfa(4yrs)- consv till” project.   

 

Click on the Open button, and the selected projects will be entered into the current Project Set table screen, as shown 

below: 

 

 
 

Click on the Select All button on the lower left corner of the screen, then press the Save Set As button on the lower 

right corner of the screen. The following window will appear: 



 33 

 

 

Enter a name for the new project set – such as“3-alfalfa-runs”, then press the Save button as shown to save the 

project set.  Return to the Project Set table, and click on the 

Run 

Selected Projects button at the bottom center of the screen.  Each of the three projects will run, and their main 

hydrology and erosion output results will be displayed in the table.  The results can be viewed and compared here.  

Results in this screen can also be copied and pasted into other Windows programs (such as Word or Excel). 
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The check boxes at the top of the screen allow you to run all of the projects in the table with the same climate, slope 

and/or soil files.  To exit this screen, click on the OK button. 
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H. Online Help 

 

Help information can be accessed on the main screen by clicking on the Help option. 

 
 

Help Topics follow standard Windows help format and include Contents, Index, and Find. 

 

 
 

Help can also be accessed on any interface window by clicking the F1 Key. 
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Section 3.  Viewing and Editing input information for Projects 

 
In the previous section you ran WEPP with the default project and changed it using prebuilt data. In this section you 

will learn how to view more detailed WEPP parameter inputs and create new data elements. 

 

A. Slope Inputs 

 

Start the WEPP program by selecting the WEPP Interface under Programs, or clicking a created shortcut icon.  The 

default project will be loaded.  The slope input for the default project is called “default”.  You can double click on 

the slope layer, or if in the display with inputs then you can click on the file icon next to the slope input name, as 

shown below. 

 
 

The Slope Profile Editor screen will appear, with the information for the “default” slope entry visible.  In the screen 

below, the slope is composed of three segments, shown in tabular form in the table on the right side and in graphical 

form in the figure to the left.  The editor allows entry of up to nine straight segments, then inserts transition curves 

between the segments.  In the advanced options the user has the capability to change the amount of transition as well 

as the slope conditions at the top and bottom of the profile. 

 

 
 

 

Let’s enter some other numbers in the table.  Length values represent horizontal distance of the segments.  Enter a 

first segment length of 15 meters with a slope of 3%, a second segment length of 12 meters with a slope of 12%, a 

third segment length of 18 meters with a slope of 1%, and a fourth segment length of 9 meters with a slope of 10%.  

Press the PreView button at the bottom left of the screen to update the graphic.  The screen will now look like this: 
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A user can alter the lengths and slope steepnesses, then Preview the profile shape until satisfied with the profile 

slope description.   

 

To set the slope width and direction (aspect) click on the Advanced button. This will display a window with some 

additional information: 
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To change the slope width type a new number in the Profile Width box. 

 

To save the current slope inputs to the database, click on the SaveAs button at the bottom of the screen.  The 

following screen will appear, and a file name can be entered or selected.  In this example, the name “example-1” 

was entered for the new slope description.  Press the Save button to save the information to the database, then press 

the OK button on the next screen. 
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This will return you to the main slope editor screen.  To use the slope inputs just entered in the current project, click 

on the Save button.  This will close the slope editor screen and return you to the default project, with the new slope 

inputs inserted, as shown on the next page. 

 



 40 

 
 

To update the display and the soil loss values, you need to Run the model again, now with the new slope inputs.  

Click on the Run button at the bottom of the screen, and let’s look at the new simulation results. 
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In the updated screen, the soil loss results displayed have changed dramatically.  The greatest amount of soil loss is 

predicted near the end of the profile.  Soil loss on the top flat portion is relatively low and on the steep middle 

section is higher.  On the flat middle section, deposition is predicted, evident by the green shading and the negative 

values shown when hovering over the area (as shown above). 

 

B. Soil Inputs 

 

Let’s now view and edit the soil inputs for the default run (as currently displayed).  To bring up the Soil Database 

Editor, double click with the mouse on the soil layer in the profile graphic, or you can also click on the file icon next 

to the Duncanon soil name at the bottom right of the screen, as shown below. 

 

 
 

The Soil Database Editor screen will appear, with the existing information for the Duncanon soil loaded as shown 

here. 

 
Other soils in the database can be loaded into the editor by clicking on the dropdown list under the Soil File Name 

header at the upper left of the screen.  The information on the top half of the editor applies to the soil as a whole, 

while properties related to the soil layers are entered in the table at the bottom of the screen. 
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Let’s assume that we have a soil similar to the Duncanon in terms of erodibility values, but some of the other 

properties are different.  Enter an albedo value of 0.20 and click the Have Model Calculate box for Effective 

Hydraulic Conductivity.  Change the top soil layer to a depth of 200 mm, sand content of 20%, clay content of 20%,  

CEC of 8, and rock fragments of 1%.  The soil will appear as follows. 

 
 

To change the color that is associated with the soil layer, click on the color button at the lower right side of the 

window (current color is pale green) as shown above.  The color screen below will appear – select a new color (pink 

has been chosen here), then click on the OK button at the bottom left of the window. 
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The color window will disappear.  To save the current soil information to a new entry in the database, click on the 

SaveAs button on the lower left of the Soil Editor screen as shown below: 
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 The Save Soil Information screen will appear, and you can type in a name for the new soil data.  Here the user has 

entered the name “example-1”, then clicked on the Add to Database button.  The second screen appears indicating 

that the new information has been added to the database under the name “example-1”. 

 
 

 

 

 

 
 

 

 

Click the OK button.  Once on the Soil Database Editor screen, you can click the Cancel button at the bottom of the 

screen to exit the editor. 

 

 

Once back on the main profile screen, hover over the soil layer with the cursor, and right click with the mouse to 

bring up the mouse options window, and select the Import option as shown in the next figure. 
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The soil selection window to the right appears – choose the 

“example-1.sol” and click on the OK button.  The small window will disappear and the soil in the current project 

will be updated to “example-1” – on the screen below notice the new color in the soil layer as well as the new soil 

name in the soil table at the bottom right of the screen. 
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Now click the Run button at the bottom of the screen, and let’s examine the effect of the new soil on model output 

results. The results are shown in the following two tables. 

 

 
 

 

 
 

 

 

 
 

 

 

You can see that the new soil increased the average annual runoff slightly (from 102 to 106mm), increased average 

annual soil loss on the regions of net detachment from 38  to 44  t/ha, and increased the profile sediment loss from 

30.7 to 36.3 t/ha.  
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Climate Inputs 

 
On the main profile screen, double click on the climate icon (sun/clouds) to bring up the Climate editor. 

 
 

 

The version of the Cligen program that is used is version 4.3. A newer version is available and can be selected by 

choosing Ver 5.3 from the selection box. Version 5.3 is the recommended version to use. 
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Clicking on the Installed Climates list on the right will display all the stations for Iowa:  

 
 

Clicking on the Map (US) button will display a map of where the stations are located. A station can be selected by 

double-clicking the left mouse button. Zoom out and choose the Hopkinsville Kentucky station: 
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After a station selected the following window is displayed: 

 
Clicking OK will return to the main climate window with that station selected: 
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With Hopinsville Kentucky selected, choose to create a 50 year continuous climate file and select the Cligen version 

5 program then click on the SaveAs button. 

 

 
 

Enter a name for the new climate input file – here the user has entered “example-50years”.  Click on the Save 

button, and the CLIGEN model will be executed in the background.   
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When complete, a message screen will appear.  Click Yes, and the new climate information will be used in the 

current project. 

 

 

On the main Profile screen, click the Run button, and let’s examine the effects of the new climate input on the model 

outputs. Precipitation has increased from 824 to 1217mm per year, runoff has increased from 102 to 157 mm per 

year, and soil loss has increased. 

 
West Lafayette, Indiana 

 
Hopkensville, Kentucky 

 

 

Let’s change the Run Options so that we can run a long simulation with our 50 year climate file.  Click on the Run 

Options button at the bottom of the main project screen. 

  

 
 

 

Change the number of simulation years from 1 to 50, and set the Graphics output so that it will not be generated.  

Then click on the OK button. 
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Returning to the main project screen, click on the Run button.  The interface will run the WEPP model for a 50 year 

simulation period, then update the results visible on t he screen. 

 

 

 

 

 

 

 

 

 

 

 

 

You can see that the average annual precipitation has decreased slightly, average annual runoff has decreased, 

average annual soil loss has decreased slightly, and average annual sediment delivery has also decreased.  If we run 

the simulation for only 1 year we will see different results from the 10 and 50 year simulations. These results 

illustrate the importance of running long simulations to obtain better average values for WEPP model predictions. 

 

 
 

 

Let’s save the project as currently configured to a new name.  Click on the File option on the main menu at the top 

of the screen. 
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Enter a name “example-1” in the File name entry field, then click on the Save button.  The current project which had 

been “default” has now been renamed as “example-1” and saved permanently.  The original “default” project has 

not been changed.   
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D.   Management Inputs 

 

In the current example click on the management layer to select it and then right click and choose the Import menu 

item. From the list of available managements choose “corn-spring chisel plow” and click OK 

. 

 
 

In the current “example-1” project, double click on the management layer.  The Cropland Management Editor will 

appear with the “corn-spring chisel.rot” rotation information loaded.  This rotation describes the management 

operations for a continuous spring chisel plow corn system.  Information on the rotation is entered in the table on the 

bottom portion of the screen.  The graphic on the top of the screen is meant to depict individual operations and 

growing periods through single or multiple rotation years.  

 

 

Note: If the WEPP Windows interface is set to display metric units the management input screens will have different 

values in many fields.  
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Since the point of this exercise is to create a new rotation, first save the existing “corn-spring chisel plow.rot” 

information to a new name, and work from with this new one.  Click on the SaveAs button as shown above.  The 

following window will appear.  Enter a name for the new rotation that we will build “example-1”, then press the 

Save button. 

 

 

 
 

 

The current rotation file displayed is now named “example-1”.  
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Let’s add operations for a soybean crop to be grown in a second year of the rotation.  We will initially use a no-till 

system. Click on the 9
th

 row of the table with the left mouse button to highlight it as shown below, then right click 

with the mouse to bring up the mouse options screen. 

 

 
 

The mouse options allow you to perform many functions in the rotation table.  You can edit the date for the current 

row, edit the operation parameters for the current row, copy, cut, delete, paste, and insert a row, insert an existing 

rotation from the database at some point in the current rotation, save highlighted rows from the table as a new 

rotation, and change the year date for a group of highlighted rows.  In this example we need to change the date to 

May 22 of year 2 of the rotation.  Select Edit Date from the list, and a calendar screen will appear.  On the month 

field, click on the dropdown arrow and scroll to select May as shown in the figure. 

 

Next, click on the year up arrow button, and increase the value to 2.  Then select the 22
nd

 with a left mouse click as 

shown, then click on the OK button.  The calendar screen will disappear and the date 5/22/2 will be entered in row 9. 
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On line 9 in the rotation table go to Operation column and click on the cell.  

 

 
 

A dropdown list icon will appear at the right of the cell.  Click on the dropdown arrow button, and a list of available 

cropland operations will appear.  Select Tillage from the list with a left mouse click. 

 

 
 

 

The Name cell will be filled with “Anhydrous applicator” as shown below. 

 

 

 

Click on the name cell to make another dropdown arrow button appear, then click on the dropdown list button. 

 

 
 

 

In the list of tillage operations, scroll down to the Drill section, then select “Drill, no-till in standing stubble – fluted 

coulter” with a left-mouse click.  The new information for the no-till drill should now be displayed in row 9 of the 

table.  (Table column and row widths can be resized if long text wrapping makes some entries hard to read.) 
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Next, let’s insert a new row with the same information as is now in row 9.  Click on row 9 column 1 with a left 

mouse click, then right click to bring up the option menu. 

 

 
 

         
 

A new row 10 will appear, with the same date and operation type as in row 9 information. 

 

 
 

 

The tillage operations address soil disturbance activities. To actually plant and start the growth of our new soybean 

crop, we need to go to the Operations column in line 10, click on the dropdown list, and select Plant-Annual, since 

we will be growing soybeans as an annual crop. 

 

 

 

 

 

The remainder of the row will then be filled in, with Alfalfa listed in the Name cell.  Go to the Name cell and click 

on the dropdown list to select a soybean crop.   We want to choose medium fertility level soybeans. 

 

Select “Soybeans – Medium Fertilization Level” from the list as shown with a left mouse click. 

 

Row 10 will now be filled in as shown below.  However the row width for the soybeans is not typical of a drill, so 

we will need to edit the soybean parameters.  To do this, click on the small folder icon to the left of the Name 

column. 
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The plant database window will appear.  This screen contains 32 parameters associated with a plant type.  We will 

only change the Row width in the entry field at the bottom left of the screen, from 30 inches (76cm) to 10 inches 

(25.4cm) 

 

Enter a value of 10 inches (25.4 cm) here, and click on the Save button. Returning to the table, line 10 now appears 

with the correct row spacing.  Next, click on line 11 column 1 with the left mouse button, then right click to bring up 

the mouse options.  Select insert row again, and the information on line 10 will be copied to line 11. 
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On line 11, go to the Operation column, and select Harvest Annual from the drop-down pick-list. 

 

 
 

Next, click with the left mouse button into the date column, and directly enter the harvest date of September 30, year 

2. 

 

 

The rotation table now contains all of the operations necessary for a two year corn-soybean rotation, as shown in the 

next figure. 

 

 
 

However, the Initial Conditions were from the original continuous corn spring chisel system, and likely do not 

contain correct information.  Click on the file icon in the Initial Conditions on line 1 of the rotation table. 

 

 
 

The Initial Conditions Database screen will 

appear.  It contains 21 parameter values related to 

initial conditions for a rotation.  Here we need to 

change the Initial Plant/Residue type in row 1 of 

the table.  Click on the Value cell for row 1, then 

scroll down the drop-down list and select 

Soybeans-Medium Fertilization  with a left mouse 

click. 
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The initial residue cover values (interrill cover and rill cover) are at 90%, which is reasonable following harvest of 

soybeans and no tillage.  If there are no other changes, click on the SaveAs button at the lower left of the screen. 

 

 

In the Create a new database record window, change the name to “Initial conditions for crop 

following no-till soybeans – example 1”, and also change the description line as shown in the 

figure below.  Then click on the OK button. 

 

 

 

Returning to the Initial Conditions Database screen, the values have now changed to the new ones we entered.  Click 

on the Save or Cancel button to exit the screen. 

 

 

Once back in the main rotation screen, the initial conditions set selected is still 

“Corn after corn” (this is an interface bug that needs to be corrected).  Click on the 

dropdown list, and choose the new initial conditions set just created. 
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At the bottom of the management editor screen, type in a new description for the new rotation as shown here. 

 

 
 

Now our final rotation table looks like this: 

 

 
 

 

Click on the Save button to save the rotation information to the database and return to the main interface project 

screen. 

 

 

 

 

Click on the Run button to run the WEPP model with the new corn and soybean rotation. The results will be 

displayed for the new 50 year simulation. 

 

 

Use the File Save option to save the current example-1 project as finally configured. 
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You might also want to print a summary sheet of your final simulation run (if your PC is connected to a printer).  To 

do this, click on the Print button or pick Print from the File options. 

 

 
 

 

You will get a print-out sheet summarizing the inputs for the simulation run as well as the erosion prediction results. 
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Section 4.  WEPP watershed simulations 
 

The previous sections explained how to use the WEPP hillslope interface.  The WEPP watershed interface allows 

multiple hillslopes, channels and impoundments to be setup. This section assumes you have already used the WEPP 

hillslope interface.  In this watershed section, the tutorial will be working in metric units, so if you would like to 

follow along with the screen images shown here, toggle to metric units using the units button.   

 

 

 

 

 

 

A. Getting Started 

To open existing watershed projects, go to the File menu at the top of the 

main interface screen, and click on Open Watershed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A window will appear listing the existing watershed projects.  Select the 

“default_ag” watershed  project, then click on the Open button. 

 

 
. 
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The watershed view window will open with the “default” watershed project loaded. 

 

 
 

 

This watershed has 3 hillslopes (H1,H2 and H3) feeding a channel (C1).  The screen graphically depicts the 

watershed as rectangular regions for the hillslopes and a single line for the channel. The watershed outlet point is 

indicated by the yellow circle at the bottom of channel C1. The red arrows on the hillslopes and channel indicate the 

direction water will flow. 

 

The watershed has an orientation which is indicated by the direction arrow in the 

upper left corner of the screen. 

 

The climate used for the simulation is indicated on the window title and also 

above the climate icon in the middle of the image. In this example, climate data 

from Xian China is being used. 

 

 

Move the mouse pointer over the image. The cursor shape will change to a hand to indicate that an object can be 

selected with the mouse.  In addition, when the mouse pointer is over a hillslope, channel or impoundment, the name 

will be displayed next to the cursor. Many operations in the watershed interface start with selecting a hillslope, 

channel or impoundment by left clicking and displaying a menu of operations by right clicking. 
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The toolbar on the right side of the window contains many functions that change the way information is displayed in 

the  watershed view. The top button is displays an additional panel of information to the right of the watershed view. 

Click on the top (legend) button. 

 

 
 

 

The watershed view will change to the following: 

 

 

 
 

 

Depending on the size of your screen you may have to resize the right panel. This can be done by clicking on the 

border on the right side of the image and then dragging the cursor. To hide the legend window and have more room 

for diagramming, click on the legend button again.  

 

The top area of the legend panel contains 5 sections that can be displayed. 

 

Click on the Site Description and Selected Component Details checkboxes. This will display comments about the 

watershed which can be edited and also a table that can display more information about selected watershed objects. 
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Move the cursor to the watershed diagram and left click on the H1 hillslope. The table should be filled in with 

information about the soil and management and the dimensions of hillslope H1. Since the WEPP model has not been 

run, the results area contains zeros. If the hillslope has several soil or management sections then each line will 

contain the name and length of the section. To change the table to view soils, management or results information 

click on the tabs below the table. 

 

Move the cursor around the watershed view and left click on the different hillslopes and channel. The table will be 

updated with information each time you left-click.  

 

One piece of information that is not displayed in the table 

is the slope shapes of the hillslopes and channel. Click on 

the Slope Profile checkbox and then left click on the H1 

hillslope. The slope shape will be displayed below the 

table:  

 

Click on the other hillslopes 

and channel to see the 

profile shapes.  The slope 

graph can be customized or 

exported  to the Windows 

clipboard. To see all the 

graph customizations right 

click on the slope graph 

window to display the menu: 

 

 

 

 

 

 

 

Any comments about the 

watershed project 

Table to display selected component 

details 

Comments about the watershed 
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To see all the managements used on the hillslopes displayed click on the management layer button  on the 

watershed toolbar.  In addition, click on the Legend checkbox. The view window will show all hillslopes in 

different colors. The legend table in right window indicates this is grass, corn and fallow. You can also hover the 

mouse pointer over the hillslopes to display the management names. 

 

 
 

Next, view the soil information. Click on the soil layer toolbar button . The watershed view will display the 

soils for the 3 hillslopes. This example shows that the watershed 

setup contains 2 soil types. The legend table indicates what soil 

types the colors represent. You can also view the soil or 

management names by moving the mouse pointer over the 

hillslopes. 
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B. Running a Simulation 

 

To run a watershed simulation click on the green circle toolbar button at the bottom of the watershed 

toolbar. (The Run button in the legend panel can also be used to start a simulation.) The WEPP model 

runs a simulation for each hillslope in the watershed and then does a final simulation to merge the results 

and simulate channels and any impoundments. The following windows will be displayed after starting a 

run: 

 

 

 

 

 

 

 

 

 

 

 

 

After a run is completed a summary table will be displayed that contains an overview of the simulation results. 

 

 
 

The first section shows results for the entire watershed and the following sections display results for the individual 

elements (hillslopes, channels, impoundments).  The interface can also display results directly on the watershed 

diagram or let the user view detailed text file outputs from the WEPP model.  

 

The toolbars buttons associated with viewing program output are the following:  

 

 

 

 

 

 

 

 

Click on the first soil loss toolbar button . The watershed view will be shaded, a darker red indicates more 

erosion, while a bright green  indicates deposition.  

View soil loss as it varies on each hillslope 

View average annual soil loss 

View average annual sediment yield 

View average  annual 

runoff 

View WEPP Text 

Output 
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Next click on the runoff output toolbar button . This will 

show the runoff amounts from the 3 hillslopes along with the 

legend indicating the ranges assigned to each shading group. 
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Text file produced from the WEPP model can be viewed by clicking on the text output toolbar button.   Click 

on the text output button and then select the Main Wepp Output file from the list by double-clicking on the name. 

 

 

This will display the WEPP summary output file in the Windows Notepad program. You can also view other output 

files produced by the model along with the input files used to setup the watershed simulation. 
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C. Zoom in , Zoom out and Measuring 

 

The toolbar icons with the magnifying glass and plus and minus signs can be used to zoom in and make the 

watershed diagram larger, or to zoom out and make it smaller.  

The scale at the bottom of the window  will change when the image zoom in 

or zoom out buttons are used. 

To measure distances between points in the watershed view the measure button  can be used. Click on this 

button and then left click at any place in the watershed window, move the mouse and then double-click on a second 

point. The distance between the two points will be displayed. As the mouse is being moved the distance from the 

first point is displayed in the lower right corner of the window. You can also measure polygon areas by clicking on 

the measure button and then clicking on each point with the last point clicked being on top of the first point. To 

indicate when the cursor is over the first point it will change to a cross with arrows. Double clicking at this point will 

display the area. 

 

 

 

 

 

 

 

 

 

 

D. Modifying the Watershed 

 

To change the management on an existing hillslope, double-click on the hillslope. For example, in the default 

project reduce the soil loss on the fallow hillslope by planting alfalfa. Double click on hillslope H3, which will 

display another window showing the hillslope details. This window functions the same way as the hillslope project 

interface. 
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Right click on the top management layer and then select the Import menu option. When the window displaying all 

the available management files is displayed, double click on the alfalfa with cutting file. This will change the 

management to alfalfa which is indicated by the green color displayed in the management layer. After changing the 

management, close the hillslope window by clicking on the X in the upper right corner. Answer Yes when asked if 

you want to save the changes. Rerun the simulation and the results will show lower erosion due to the new 

management. 

 

 

E. Adding an Impoundment 

 

Now add an impoundment object at the end of the channel. This can be done by left-clicking on channel C1 to select 

it. When a channel is selected it is displayed as a red line. After the channel is selected, right-click to display a menu 

of options. 

 

Select the last menu option Add Impoundment and from the 

sub-menu choose On Bottom.  Move the mouse pointer 

around near the channel outlet. An outline of a triangle will be 

drawn as the mouse is moved. The outline represents how the 

impoundment will be represented in the diagram. When you 

have a small triangle, left-click to display the impoundment 

icon. 

 

The terminating point of the 

watershed is now the 

impoundment that was added. 

Rerun the simulation and notice 

that the discharge volume for the 

watershed has gone down. 
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F. Adding a Channel 

 

Next, delete the impoundment by selecting it (left-click) and then pressing the Delete 

key. You can also right-click and choose the Delete menu option to remove an object.  

 

Select channel C1 by left 

clicking and then right-click 

and choose the Add Channel 

menu option.  From the sub-

menu choose On Bottom. 

Move the mouse pointer 

around, an outline of where the 

channel will be placed is 

drawn. When the desired 

position is found, left-click to 

place the channel and then 

choose Yes from the window 

that is displayed. 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

If the channel and hillslope names are not 

displayed click on the Options menu at the 

top of the program window and select the 

Element Names item. The new channel 

added is named C2.  A channel in WEPP can have elements feeding it from the top, left 

and right sides.  Currently C2 is being fed by C1.   
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After Clicking Yes to place the channel a window will be displayed that allows the parameters for the channel to be 

set.  Change the soil type to Belmore and the slope shape to s-shape and then click save.  The channel management 

is changed by clicking on the folder next to the channel type that contains additional channel parameters. New slope 

shapes can be created with the slope editor by clicking on the folder next to slope shape list.  

 

G. Adding a Hillslope 

Hillslopes can be added to the sides of the channel by 

first right-clicking on the channel to display the 

channel menu and then selecting Add Hillslope, from 

the sub-menu select On Downstream Left.  This will 

display a window to allow a hillslope project be 

loaded and assigned to side of the channel. 

Click OK to load the alfalfa hillslope.  

 

The default is for the new hillslope width to be equal 

to the channel length and the hillslope length to be 

defined by the alfalfa project. The dimensions, soil, 

management and slope can be changed on a hillslope 

after it is loaded. After adding a hillslope to the 

downstream left of C1, repeat the process and add 

another hillslope to the downstream  right side. After 

adding the hillslopes the watershed should look 

something like this: 

 



 76 

The background image can also be turned off and a solid color used instead. To change the background to a solid 

color click on the Tools menu at the top of the program window and select Change Background. From the sub-

menu choose Color. From the color chooser window click on a new color to use as the background 

 

The watershed diagram will probably now extend beyond the image. At this point the whole watershed can be 

moved around on the screen by clicking on the C2 channel with the left mouse button, holding the mouse down and 

dragging the watershed around the screen.  Releasing the mouse button will drop the watershed. 

 

Change the background to a solid color. The resulting watershed diagram should look something like the following 

after changing the background and then clicking on the management layer toolbar button: (the background may be 

different depending of what color you chose). 

 

The WEPP model can be run at this point to 

view what effect adding a channel and two 

hillslopes has on the simulation. 
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H. Watershed Configuration   

Using the same procedure, additional channels, hillslopes and impoundments can be added to the watershed. When 

building watershed configurations for simulations the WEPP model imposes some rules about how elements are 

connected. Any channel or impoundment must have at least one input that drains into it. The interface will gray-out 

menu items that are not valid for the current element selected. For example, for channel C1 no additional elements 

can be added because it already has elements connected to the top, left and right (H1,H2,H3) and bottom C2. If C2 is 

selected additional elements can be added. Select channel C2 and then right-click and select Add Channel  from the 

sub-menu choose On Downstream Right Move the cursor around to draw the channel as being an input for C2.  

 

 

 

At this point the new channel is C3 and it has no input element draining into it. Before a simulation can be run, an 

imput must be defined for C3. To do this, select C3, right click and choose the Add Hillslope menu item and then 

On Top. Select the alfalfa project and choose OK. The hillslope will be assigned to the top of C3 but will be very 

narrow. To increase the size, left click on the new hillslope and drag a side to a new position. As the side is being 

dragged an outline will be displayed indicating the new hillslope shape. The new hillslope has the identifier H6.  
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Channel lengths can be changed by selecting the channel and then moving the cursor over the end of the channel 

until it changes to a cross. Clicking and dragging the end of the channel at this point will change its length.  

 

Sometimes it is necessary to set an exact length or width to a channel or hillslope. This can be done by selecting the 

channel or hillslope and then right-clicking and choosing the Change Length or Change Width menu items.  

Change the length of the new channel C3 to be a little longer: 

Type in a new length  about 5 meters longer and click OK.  

 

After configuring the watershed the new setup can be saved to a watershed project. To save your changes click on 

the File menu and select the Save As menu item.  

 

When the File Save window is displayed, type in a new name where the project information will be saved. 

 

The watershed diagram and summary results can be sent to the printer. From the File menu select Print Preview or 

Print.
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Changing Channel Properties 
 

Each channel in the watershed configuration has a set of properties that can be changed. This includes the length, 

width, slope shape, soil, management and other parameters.  

 

To view all the details associated with a channel, double click on a channel to display the channel editor window. 

The following is displayed if you double click on the C1 channel. 

 

 
 

The soil associated with the channel can be changed by selecting a new soil from the list. The detailed soil 

parameters can be viewed or changed by clicking on the folder next to the soil list.  

 

The default slope 

assigned to channels is 

a uniform 5%. The 

slope shape for the 

channel can be 

changed by selecting a 

new shape from the 

list or clicking on the 

folder and using the 

slope editor to create a 

new slope profile.   

 

The Channel Type 

selection contains 

parameters that define 

the channel, click on 

the folder button next 

to the selection box to 

display the channel 

editor window: 
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For information on the parameter definitions, consult the online help or the WEPP Users Guide.  One of the most 

important parameters is the channel management. The last line indicates this channel has a fallow management.   

 

Next create a new channel definition with all the same properties as the Waterway definition, except that the channel 

management will be  set to a continuous grass.  From the management parameter dropdown list select the contGrass 

definition.  Since the channel parameters have changed, the new parameter set should be saved to a different name. 

Click on the Save As button and then change the name to “Waterway (grass)”: 

 

Click OK to close the window. 

 

From the channel parameter window click Cancel to return to the main channel editor window. From the channel 

type dropdown select the new channel definition you just created. The management line will display the 

management used (continuous grass).  After selecting the new channel definition, click Save. 

 

 
 

If the WEPP simulation is rerun, you should see slightly different results for the discharge volume and sediment 

yield for C1 based on the changed parameters. 

 

In addition to changing channel parameters from the channel editor, the right-click menu from a channel selection 

has options to import a soil, slope, or to change the length and width.  
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I. Changing Impoundment Properties 

 
Return to the original watershed configuration with a single channel and 3 hillslopes. Close the current watershed 

window by clicking on the X in the upper right corner. When asked if you want to save changes, click No. To reload 

the default watershed click on the File menu and choose Open Watershed.  From the window that is displayed 

click on the file “default”. 

 

When the watershed window is displayed, add an impoundment on the end of channel C1 by left-clicking to select 

the channel and then right click to display the channel menu and select Add Impoundment. The only position at 

which an impoundment can be attached to C1 is at the bottom, so select On Bottom from the sub-menu that is 

shown. Move the cursor so that impoundment triangle icon is small enough and then left-click. 

 

 
The impoundment is added with a default set of parameters. The default configuration is for a culvert. To view or 

edit the parameters associated with an impoundment, double click  on the selected impoundment. The following 

window is displayed: 

 

 

The diagram in the upper right can be expanded to show a representation of different model parameters associated 

with a culvert definition. Left-click on the diagram to show a larger image. An impoundment definition for the 

WEPP model can be composed of several different impoundment types. The Present checkbox column on the left 

indicates if that type of impoundment structure is present in this definition.  The impoundment name contains a list 
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of prebuilt impoundenment definitions.  The folder icons next to each impoundment type will show more detailed 

parameters associated with each impoundment type. Clicking on the folder next to culvert will display the 

parameters associated with the impoundment: 

 
New impoundment definitions are created in a manner similar to other parameter definitions in the WEPP interface. 

Use the Save As button to create a new record type and then customize the parameters. The impoundment setups 

contain many parameters, consult the online help and WEPP Users Guide and Technical Summary for all the 

definitions.  

 

Click on the Cancel button to exit the impoundment editor and return to the watershed view window.  

 

The WEPP install comes with some prebuilt impoundment definitions.  To use a different definition select the 

impoundment in the diagram and then right click to display the impoundment menu. 

 

Select Import Impoundment and then Perforated Riser from the import window.
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Click the run button to rerun the simulation and you should see different results for the discharge volume and 

sediment yield for the watershed because of the different impoundment. 

 

J. Changing the Run Options 

 

To change what output files WEPP will produce and how many years the simulation will run for, click on the Run 

Options toolbar button  which will display a list of options.  

 

 
 

Change the simulation length from 2 years to 5 years and then click OK. Then click the run button to re-run the 

simulation. You should see slightly different results due to the longer simulation.  

 

In most cases, the runoff peak calculation method should be the modified EPIC, and not the CREAMS option.  For 

details on the other run options consult the online help. 

 

Return Period Analysis 

 

To look at watershed recurrence intervals or return periods click 

on the run options button and select the Return Period Summary 

item and also set the number of years to simulate to be 100. 
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After returning to the main watershed view click the run button (green dot on right toolbar). To view the return 

period outputs click on the tools menu and select Return Period Analysis 

 

 
 

This will display a table of  the return period results.  The columns can also be graphed by clicking on the Display 

button. 
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Setting up a New Watershed 
 

The steps to setting up a completely new watershed are essentially to start  with an existing watershed and customize 

it. 

 

1. Save the current default watershed under a new name by selecting File|Save As 

 

2. Delete all watershed elements by selecting each element and then using the Delete key. The interface places some 

restrictions on the order in which elements can be removed. For example, a channel can not be deleted if it is in the 

middle of the disgram and has other channels and hillslopes attached to it. The outer elements must be deleted first. 

 

3. Select a new background image by clicking on the Tools menu item and then Change Background and then 

Import Image on the sub-menu. The current interface supports using .BMP and JPG files as the background. A 

good source of JPG images is www.terraserver.com 

 

4. Scale the image so that any diagramming done will have the correct lengths and widths for the watershed 

elements. To scale the image click on the Tools menu item and select Scale Map. This requires that 2 points be 

picked on the image where the real world distance between them is known.  

Type in the correct distance between the 2 selected points.  

 

5. Set the orientation for the North direction. This can be done by double-clicking on the direction circle in the upper 

left corner of the window or clicking the Tools menu and selecting Set Direction. The compass window will be 

displayed.  Click in the white center to indicate in which direction North should be set to. To save the setting click 

the Set button. 

 
 

6. Next the climate can be set. This is done by right clicking on the climate icon in the center of the image and then 

selecting Import to load a prebuilt climate file. To create a new climate file double click on the climate icon or 

choose View/Edit from the right-click menu. How to build new climate files is explained in the hillslope section of 

this tutorial. 

 

7. After setting up the image, scale, orientation and climate you are ready to begin building a new watershed 

configuration. To begin right-click anyplace in the image background and select Add Channel from the menu.  

http://www.terraserver.com/
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The cursor will change to a cross hair. Click on a point on the image where you want the channel outlet to be placed. 

Move the cursor to a new point where the start of the channel is found and click again. The display will show the 

starting channel C1 and the outlet as a yellow circle. 

 

 

 

 

 

After the first channel is added more hillslopes, channels and 

impoundments can be added by right clicking on any element and then 

choosing the approiate Add menu option. 

 

 

 

 

 

 

 

Hillslope Polygon View 
 

The watershed  view can display hillslopes as polygons. The polygons can be reshaped to match field boundaries on 

an image. The WEPP simulation will use a representative hillslope rectangle. A representative hillslope is one that 

has the same area as the polygon.  

 

Reopen the default project, then click on the polygon view toggle button  to display the following view: 

 

You’ll notice that hillslope H1 is actually shaped as a 

polygon here, not a rectangle. 

 

To reshape a hillslope left click on hillslope, this will display 

the vertex points. 

 

Click on a vertex and drag to change the shape. New points 

can be added by double-clicking on the hillslope border. 

 
 

To delete a vertex point right click while over the point and select the View As Polygon menu item and then select 

Delete Vertex. 

 

To return to rectangle view click on the polygon view toolbar button. The representative rectangle area will always 

match the polygon area. 
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Watershed View Preferences 
 

To set preferences for the watershed interface click on the Options menu and then click on the Preferences item. 

When the preferences window is displayed click on the Watershed tab. 

 

The Setup Legend Options determines how shading will be done for soil loss, sediment yield and runoff.  For each 

color setting a minimum and maximum range can be set. To use less than the 5 color divisions leave any unused 

setting blank.  All possible ranges for a particular shading type should be specified. In the watershed view if a value 

does not map into a color range then white is used as the color. To change the color for a particular shading type 

click on the Select Base Color and choose a new color from the window displayed. 

 

The watershed view can also determine the shading divisions automatically by using the minium and maximum 

values from the WEPP output and then dividing the range into 5 equal segments. To have the interface compute the 

equal divisions based on the program output click on the Shading Dynamically checkbox. 

 

The width of the hillslopes on the left and right sides of a channel can be set to always have the same length of the 

channel they border. This can be done by clearing the Show Option Dialog checkbox and checking the Make 

Hillslope length equal to the channel length.  
 

When the watershed view is changed from rectangle to polygons some shading operations can not be done. Clicking 

on the Show warning when hillslope changed to polygon will enable the interface to inform the user that some 

operations will not be available in the polygon view. 

 

The thickness of the hillslope borders and channel lines can be set. A value of 0 will always draw a line, increasing 

values will draw thicker lines. 

 

The last selection, Use normalized scale in drawing slopes, determines the scale of the slope profile graph in the 

legend window. To display all profiles using the same X and Y scales this checkbox should be selected. If the 

checkbox is cleared then each graph will be drawn so the selected slope profile fills the entire graph. 


